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Introduction to MODFLOW 

MODFLOW is a block-centered finite difference code that can simulate all of the aquifer types. It 

basically solves the groundwater flow equation of the form shown below.  
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The sophistication present in MODFLOW means that the input assembly is complex, and readers 

are referred to the user's manual (McDonald and Harbaugh, 1988) for details. Preprocessors are 

available to help with data assemble and post-processors can assist in viewing the output 

(Rumbaugh and Duffield, 1989). Several features of the model are highlighted below. 

Specifying the Vertical Grid Spacing 

MODFLOW views a three-dimensional system as a sequence of layers of porous material (Fig. 

1.2). The horizontal grid is generated in the usual way by specifying grid dimensions in the x and 

y directions. As with all finite difference grids, the horizontal grid must be the same for each layer. 

The model does not require input of a Δz array. Instead Δz is specified indirectly. The user may 

input layer transmissivities, which are equal to the hydraulic conductivity of the layer times the 

layer thickness (Δz). Alternatively, the user may input hydraulic conductivity arrays for each layer 

and arrays giving the elevation of the top and bottom of the layer. MODFLOW then calculates 

transmissivity for the layer after first computing layer thickness from the top and bottom 

elevations. 

Transmissivity at each (i , j) location within a layer may vary owing to spatial variations in aquifer 

thickness and/or hydraulic conductivity. This means that in effect Δz varies spatially within a layer. 

This procedure allows greater flexibility in fitting hydrostratigraphic units into a finite difference 

grid (Fig. a). However, it distorts the layers (Fig. b), thereby introducing error into the finite 

difference approximation. According to McDonald and Harbaugh (1988), the error is generally 

small. 
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Fig. a Fitting layers to irregularly shaped hydrostratigraphic units (Peters, 1987). 

 

Fig. b Distortion of hydrostratigraphic layers is preserved in the block-centered grids used in 

MODFLOW by adjusting layer transmissivities (McDonald and Harbaugh, 1988). 
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Types of Model Layers 

Layers may be designated as always confined, always unconfined, or capable of being either 

confined or unconfined (convertible). If the layer is confined, the user inputs the transmissivity 

and storage coefficient of the layer. The top layer in the system is typically designated to be 

unconfined and the user inputs the hydraulic conductivity, specific yield, and the bottom of the 

layer. MODFLOW calculates the transmissivity of the layer by multiplying hydraulic conductivity 

by the saturated thickness of the layer. Heads in the layer are calculated under the Dupuit 

assumptions. After each iteration, the saturated thickness in the layer is updated and new 

transmissivities are calculated. MODFLOW allows the water table to rise to infinity in the top 

unconfined layer. That is, the top layer is assumed to be infinitely thick. 

If the layer is designated to be convertible, hydraulic conductivities and the elevations of the top 

and bottom of the aquifer are input and MODFLOW calculates layer transmissivities. After each 

iteration the model checks to determine whether the head in the layer is above or below the 

elevation of the top of the layer. If the head in the layer is higher than the elevation of the top of 

the layer, the layer is assumed to be confined. If the head in the layer is less than the elevation of 

the top of the layer, the layer is assumed to be unconfined. 

The VCONT Arrays 

For MODFLOW simulations involving more than one layer, the user must calculate a vertical 

transmission or leakage term, known as VCONT, for each nodal block in the grid, except for blocks 

in the bottom layer. A VCONT array is not required for the bottom layer because the model 

assumes that the bottom layer VCONT is zero. VCONT is a function of the vertical hydraulic 

conductivity between layers and the thickness of the layers.  

Tutorial on PMWIN 

The tutorials provide an overview of the modeling process with PMWIN Pro, describe the basic 

skills you need to use PMWIN Pro, and take you step by step through hypothetical problems. Each 

tutorial is divided into three parts. It starts out with Folder, where you can find the ready-to-run 

model, for example pmdir\examples\tutorials \tutorial1\, where pmdir is the installation folder of 

PMWIN. Next, you’ll find a discussion of the hypothetical problem, and the step-by-step tutorial 

will walk you through the tasks. 
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Your First Groundwater Model with PMWIN 

Overview of the Hypothetical Problem 

It takes just a few minutes to build your first groundwater flow model with PMWIN. First, create 

a groundwater model by choosing New Model from the File menu. Next, determine the size of the 

model grid by choosing Mesh Size from the Grid menu. Then, specify the geometry of the model 

and set the model parameters, such as hydraulic conductivity, effective porosity etc. Finally, 

perform the flow simulation by choosing selecting Models | MODFLOW | Run. 

After completing the flow simulation, you can use the modeling tools provided by PMWIN to view 

the results, to calculate water budgets of particular zones, or graphically display the results, such 

as head contours. You can also use PMPATH to calculate and save path lines. 

As shown in Fig. 1.1, an aquifer system with two stratigraphic units is bounded by no flow 

boundaries on the North and South sides. The West and East sides are bounded by rivers, which 

are in full hydraulic contact with the aquifer and can be considered as fixed head boundaries. The 

hydraulic heads on the west and east boundaries are 9 m and 8 m above reference level, 

respectively. 

 

Fig. 1.1. Configuration of the hypothetical model 
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The aquifer system is unconfined and isotropic. The horizontal hydraulic conductivities of the first 

and second stratigraphic units are 0.0001 m/s and 0.0005 m/s, respectively. Vertical hydraulic 

conductivity of both units is assumed to be 10 percent of the horizontal hydraulic conductivity. 

The effective porosity is 25 percent. The elevation of the ground surface (top of the first 

stratigraphic unit) is 10m. The thickness of the first and the second units is 4 m and 6 m, 

respectively. A constant recharge rate of 8×10-9 m/s is applied to the aquifer. A contaminated area 

lies in the first unit next to the west boundary. The task is to isolate the contaminated area using a 

fully penetrating pumping well located next to the eastern boundary. 

A numerical model has to be developed for this site to calculate the required pumping rate of the 

well. The pumping rate must be high enough so that the contaminated area lies within the capture 

zone of the pumping well. We will use PMWIN to construct the numerical model and use 

PMPATH to compute the capture zone of the pumping well. 

Run a Steady-State Flow Simulation 

Six main steps must be performed in a steady-state flow simulation: 

1. Create a new model 

2. Assign model data 

3. Perform the flow simulation 

4. Check simulation results 

5. Calculate zonal water budget 

6. Produce output 

Step 1: Create a New Model 

The first step in running a flow simulation is to create a new model. 

➢ To create a new model 

1. Select File | New Model. A New Model dialog box appears. Select a folder for saving the model 

data, such as C:/Models/tutorial1, and type the file name TUTORIAL1 as the model name. A 

model must always have the file extension .PM5. All file names valid under MS-Windows with 

up to 120 characters can be used. It is a good idea to save every model in a separate folder, where 

the model and its output data will be kept. This will also allow PMWIN to run several models 

simultaneously (multitasking). 
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2. Click OK. 

PMWIN takes a few seconds to create the new model. The name of the new model name is shown 

in the title bar. 

Step 2: Assign Model Data 

The second step in running a flow simulation is to generate the model grid (mesh), specify cell 

status, and assign model parameters to the model grid. 

PMWIN requires the use of consistent units throughout the modeling process. For example, if you 

are using length [L] units of meters and time [T] units of seconds, hydraulic conductivity will be 

expressed in units of [m/s], pumping rates will be in units of [m3/s] and dispersivities will be in 

units of [m]. 

In MODFLOW, an aquifer system is replaced by a discretized domain consisting of an array of 

nodes and associated finite difference blocks (cells). Fig. 1.2 shows the spatial discretization 

scheme of an aquifer system with a mesh of cells and nodes at which hydraulic heads are 

calculated. The nodal grid forms the framework of the numerical model. Hydrostratigraphic units 

can be represented by one or more model layers. The thickness of each model cell and the width 

of each column and row may be variable. PMWIN uses an index notation [Column, Row, Layer] 

for locating the cells. For example, the cell located in the first layer, 6th row, and 2nd column is 

denoted by [2, 6, 1]. In this example, the model domain is discretized in cells of horizontal 

dimensions of 20 m by 20 m. The first stratigraphic layer is represented by the first model layer 

and the second stratigraphic layer is represented by two model layers. It is to note that a higher 

resolution in the vertical direction is often required in order to correctly simulate the migration of 

contaminants. 
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Fig. 1.2. The spatial discretization scheme and cell indices of MODFLOW 

➢ To generate the model grid 

1. 

Select Grid | Mesh Size. 

The Model Dimension dialog box appears 

(Fig. 1.3).  

 

Fig. 1.3. The Model Dimension dialog box

2. Enter 3 for the number of layers, 10 for model thickness, 30 for the numbers of rows and 

columns, 20 for the size in both row and column directions. 

PMWIN generates a uniform grid based on the specified dimensions. Later, the grid may be refined 

and the layer elevations can be adjusted. In this example, the first and second stratigraphic units 

will be represented by one and two model layers, respectively. 
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3. Click OK. PMWIN changes the pull-down menus and displays the generated model grid (Fig. 

1.4). PMWIN allows you to shift or rotate the model grid, change the width of each model column 

or row, or to add/delete model columns or rows. For this example, you do not need to modify the 

model grid. Refer to Help Section for more information about the Grid Editor. 

 

Fig. 1.4. The generated model grids 

4. Select File | Leave Editor or click the leave editor button . 

The next step is to specify the type of layers and the cell status array of the flow model. The cell 

status array (IBOUND array) contains a code for each model cell which indicates whether (1) the 

hydraulic head is computed (referred to as active variable-head cell or active cell), (2) the hydraulic 

head is kept fixed at a given value (referred to as fixed-head cell, constant-head cell, or time-

varying specified-head cell), or (3) no flow takes place within the cell (referred to as inactive cell). 

Use 1 for an active cell, -1 for a constant-head cell, and 0 for an inactive cell. For this example, 

the value -1 needs to be assigned to the cells on the west and east boundaries and the value 1 to all 

other cells. Any outer boundary cell, which is not a constant-head cell, is automatically a zero flux 

(no flow) boundary cell. Flux boundaries with non-zero fluxes are simulated by assigning 

appropriate infiltration or pumping wells in the corresponding active cell via the well package. 
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Head-dependent boundary conditions are modeled on active cells by means of the general head 

boundary package or the river package. 

➢ To define the layer properties 

1. Select Grid | Layer Type. A Layer Options dialog box appears. 

2. Click a cell of the Type column, a drop-down button will appear within the cell. By clicking the 

drop-down button, a list containing the available layer types (Fig. 1.5) will be displayed. 

 

Fig. 1.5. The Layer Options dialog box and the layer type drop-down list 

3. Select 1: Unconfined for the first layer and 3: Confined/Unconfined (Transmissivity Varies) for 

the other layers then click OK to close the dialog box. 

➢ To assign the cell status to the flow model 

1. Select Grid | Boundary Conditions | IBOUND (Modflow). The Data Editor of PMWIN appears 

and displays the model grid (Fig. 1.6). A grid cursor is located over the current cell. The value of 

the current cell is shown at the bottom of the status bar. The default value of the IBOUND array 

is 1. The grid cursor can be moved by using the arrow keys, by clicking the mouse on the desired 

position, or by using buttons in the tool bar. To jump to another layer, click the Layer edit box in 

the tool bar, type the new layer number, and then press enter. Note. A DXF-map is loaded by using 

the Maps Options dialog box. See Help Section for details. 
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Fig. 1.6. The Data Editor displaying the plan view of the model grid 

2. Move the grid cursor to the cell [1, 1, 1] and press the Enter key or the right mouse button to 

display a Cell Value dialog box. 

3. Type -1 in the dialog box, then click OK. The upper-left cell of the model has been specified to 

be a constant-head cell. 

4. Now turn on duplication by clicking the duplication button . Duplication is on, if the 

duplication button is depressed. The current cell value will be duplicated to all cells passed by the 

grid cursor, if it is moved while duplication is on. Duplication is turned off by clicking the 

duplication button again. 

5. Move the grid cursor from the upper-left cell [1, 1, 1] to the lower-left cell [30, 30, 1] of the 

model grid. The value of -1 has now been duplicated to all cells on the west side of the model. 

6. Move the grid cursor to the upper-right cell [30, 1, 1] by clicking on this cell. 

7. Move the grid cursor from the upper-right cell [1, 1, 30] to the lower-right cell [30, 30, 1]. The 

value of -1 has now been duplicated to all cells on the east side of the model. 

8. Turn on layer copy by clicking the layer copy button . Layer copy is on, if the layer copy 

button is depressed. The cell values of the current layer will be copied to other layers, if model 
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layer is changed while layer copy is on. Layer copy can be turned off by clicking the layer copy 

button again. 

9. Move to the second layer and then to the third layer by pressing the PgDn key twice. The cell 

values of the first layer are copied to the second and third layers. 

10. Select File | Leave Editor or click the leave editor button . 

The next step is to specify the geometry of the model. 

➢ To specify the elevation of the top of model layers 

1. Select Grid | Top of Layers (TOP). A Top of Layers (TOP) dialog box appears and asks if the 

layer bottom elevation should be used for the layer top elevation. 

2. In the Top of Layers (TOP) dialog box, click No. PMWIN displays the model grid. 

3. Move the grid cursor to the first layer if it is not in the first layer. 

4. Select Value | Reset Matrix (or press Ctrl+R). A Reset Matrix dialog box appears. 

5. Enter 10 in the dialog box, then click OK. The elevation of the top of the first layer is set to 10. 

6. Move to the second layer by pressing PgDn. 

7. Repeat steps 3 and 4 to set the top elevation of the second layer to 6 and the top elevation of the 

third layer to 3. 

8. Select File | Leave Editor or click the leave editor button . 

➢ To specify the elevation of the bottom of model layers 

1. Select Grid | Bottom of Layers (BOT). 

2. Repeat the same procedure as described above to set the bottom elevation of the first, second 

and third layers to 6, 3 and 0, respectively. 

3. Select File | Leave Editor or click the leave editor button . 
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We are going to specify the temporal and spatial parameters of the model. The spatial parameters 

for sample problem include the initial hydraulic head, horizontal and vertical hydraulic 

conductivities and effective porosity. 

➢ To specify the temporal parameters 

1. Select Parameters | Time. A Time Parameters dialog box appears. The temporal parameters 

include the time unit and the numbers of stress periods, time steps and transport steps. In 

MODFLOW, the simulation time is divided into stress periods - i.e., time intervals during which 

all external excitations or stresses are constant - which are, in turn, divided into time steps. Most 

transport models divide each flow time step further into smaller transport steps. The length of 

stress periods is not relevant to a steady state flow simulation. However, as we want to perform 

contaminant transport simulation, the actual time length must be specified in the table. 

2. Enter 9.46728E+07 (seconds) for the Length of the first period. 

3. Click OK to accept the other default values. This implies that a steady state flow simulation will 

be carried out. 

Now, we need to specify the initial hydraulic head for each model cell. The initial hydraulic head 

at a constant-head boundary will be kept the same throughout the flow simulation. The other 

hydraulic head values are used as starting values in a transient simulation or first guesses for the 

iterative solver in a steady-state simulation. Here we firstly set all values to 8 and then correct the 

values on the west side by overwriting them with a value of 9. 

➢ To specify the initial hydraulic head 

1. Select Parameters | Initial & Prescribed Hydraulic Heads to display the model grid. 

2. Move the grid cursor to the first layer. 

3. Select Value | Reset Matrix (or press Ctrl+R) and enter 8 in the dialog box, then click OK. 

4. Move the grid cursor to the cell [1, 1, 1] and press the Enter key or the right mouse button to 

display a Cell Value dialog box. 

5. Enter 9 into the Cell Value dialog box, then click OK. 
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6. Now turn on duplication by clicking on the duplication button . 

7. Move the grid cursor from the upper-left cell [1, 1, 1] to the lower-left cell [30, 1, 1] of the 

model grid. The value of 9 is duplicated to all cells on the west side of the model. 

8. Turn on layer copy by clicking the layer copy button . 

9. Move to the second layer and the third layer by pressing PgDn twice. The cell values of the first 

layer are copied to the second and third layers. 

10. Select File | Leave Editor or click the leave editor button . 

➢ To specify the horizontal hydraulic conductivity 

1. Select Parameters | Horizontal Hydraulic Conductivity. PMWIN displays the model grid. 

2. Move the grid cursor to the first layer. 

3. Select Value | Reset Matrix (or press Ctrl+R), enter 0.0001 in the dialog box, then click OK. 

4. Move the grid cursor to the second layer. 

5. Select Value | Reset Matrix (or press Ctrl+R), enter 0.0005 in the dialog box, then click OK. 

6. Move the grid cursor to the third layer. 

7. Select Value | Reset Matrix (or press Ctrl+R), enter 0.0005 in the dialog box, then click OK. 

8. Select File | Leave Editor or click the leave editor button . 

➢ To specify the vertical hydraulic conductivity 

1. Select Parameters | Vertical Hydraulic Conductivity. PMWIN displays the model grid. 

2. Move the grid cursor to the first layer. 

3. Select Value | Reset Matrix (or press Ctrl+R), enter 0.00001 in the dialog box, then click OK. 

4. Move the grid cursor to the second layer. 
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5. Select Value | Reset Matrix (or press Ctrl+R), enter 0.00005 in the dialog box, then click OK. 

6. Move the grid cursor to the third layer. 

7. Select Value | Reset Matrix (or press Ctrl+R), enter 0.00005 in the dialog box, then click OK. 

8. Select File | Leave Editor or click the leave editor button . 

➢ To specify the effective porosity 

1. Select Parameters | Effective Porosity. PMWIN displays the model grid. Since the default value 

of 0.25 is the same as the prescribed value, nothing needs to be done here. Note that although a 

flow simulation does not require the effective porosity, it is necessary for the computation of travel 

times and contaminant transport processes. 

2. Select File | Leave Editor or click the leave editor button . 

➢ To specify the recharge rate 

1. Select Models | MODFLOW | Recharge. 

2. Select Value | Reset Matrix (or press Ctrl+R), enter 8E-9 for Recharge Flux [L/T] in the dialog 

box, then click OK. Note this works only for the top layer. 

3. Select File | Leave Editor or click the leave editor button . 

The last step before performing the flow simulation is to specify the location of the pumping well 

and its pumping rate. In MODFLOW, an injection or a pumping well is represented by a node (or 

a cell). The user specifies an injection or a pumping rate for each node. It is implicitly assumed 

that the well penetrates the full thickness of the cell. MODFLOW can simulate the effects of 

pumping from a well that penetrates more than one aquifer or layer provided that the user supplies 

the pumping rate for each layer. The total pumping rate for the multilayer well is equal to the sum 

of the pumping rates from the individual layers. The pumping rate for each layer (Qk) can be 

approximately calculated by dividing the total pumping rate (Qtotal) in proportion to the layer 

transmissivity (McDonald and Harbaugh 1988): 
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𝑄𝑘 = 𝑄𝑇𝑜𝑡𝑎𝑙 ×
𝑇𝑘
∑𝑇

 

where Tk is the transmissivity of layer k and ΣT is the sum of the transmissivities of all layers 

penetrated by the multi-layer well. Unfortunately, as the first layer is unconfined, we do not exactly 

know the saturated thickness and the transmissivity of this layer at the position of the well. The 

above Equation cannot be used unless we assume a saturated thickness for calculating the 

transmissivity. Another possibility to simulate a multi-layer well is to set a very large vertical 

hydraulic conductivity (or vertical leakance), e.g. 1 m/s, to all cells of the well. The total pumping 

rate is assigned to the lowest cell of the well. For the display purpose, a very small pumping rate 

(say, 1 × 10−10m3/s) can be assigned to other cells of the well. In this way, the exact extraction rate 

from each penetrated layer will be calculated by MODFLOW implicitly and the value can be 

obtained by using the Water Budget Calculator (see below). 

Since we do not know the required pumping rate for capturing the contaminated area shown in 

Fig. 1.1, we will try a total pumping rate of 0.0012 m3/s. 

➢ To specify the pumping well and the pumping rate 

1. Select Models | MODFLOW | Well. 

2. Move the grid cursor to the cell [25, 15, 1] and press the Enter key or the right mouse button to 

display a Cell Value dialog box. 

3. Type -1E-10 in the dialog box, then click OK. Note that a negative value is used to indicate a 

pumping well. 

4. Move the grid cursor to the cell [25, 15, 2] and press the Enter key or the right mouse button to 

display a Cell Value dialog box. 

5. Type -1E-10 in the dialog box, then click OK. 

6. Move the grid cursor to the cell [25, 15, 3] and press the Enter key or the right mouse button to 

display a Cell Value dialog box. 

7. Type -0.0012 in the dialog box, then click OK. 
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8. Select File | Leave Editor or click the leave editor button . 

9. Select File | Leave Editor or click the leave editor button . 

Step 3: Perform the Flow Simulation 

Before starting the computation, a solver has to be chosen. This example uses the default solver 

PCG2 with its default settings.  

➢ To perform the flow simulation 

1. Select Models | MODFLOW | Run: The Run Modflow dialog box appears (Fig. 1.7). 

 

Fig. 1.7. The Run Modflow dialog box 

2. Click OK to start the flow simulation. Prior to running MODFLOW, PMWIN will use the user-

specified data to generate input files for MODFLOW (and optionally MODPATH) as listed in the 

table of the Run Modflow dialog box. An input file will be generated only if its generate flag is set 
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to . Normally, the flags do not need to be changed, since PMWIN will take care of the settings 

automatically. If necessary, click on the check box to toggle the generate flag between  and . 

Step 4: Check Simulation Results 

During a flow simulation, MODFLOW writes a detailed run record to path/OUTPUT.DAT, where 

path is the folder in which the model data are saved. When a flow simulation is completed 

successfully, MODFLOW saves the simulation results in various unformatted (binary) files as 

listed in Table 1.1. Prior to running MODFLOW, the user may control the output of these 

unformatted (binary) files by choosing Models | MODFLOW | Output Control. 

Table 1.1 Output files from MODFLOW 

File Contents 

path\OUTPUT.DAT Detailed run record and simulation report 

path\HEADS.DAT Hydraulic heads 

path\DDOWN.DAT Drawdowns, the difference between the starting heads and the 

calculated hydraulic heads. 

path\BUDGET.DAT Cell-by-Cell flow terms. 

path\INTERBED.DAT Subsidence of the entire aquifer and compaction and pre-

consolidation heads in individual layers. 

path\MT3D.FLO Interface file to MT3D/MT3DMS. This file is created by the 

LKMT package provided by MT3D/MT3DMS (Zheng 1990, 

1998). 

- path is the folder in which the model data are saved. 

The system of equations of the finite difference model MODFLOW actually consists of a flow 

continuity statement for each model cell. Since MODFLOW uses iterative equation solvers, the 

accuracy of the simulation results need to be checked after each simulation run. Continuity should 

exist for the total flows into and out of the entire model or any zones of the model. This means that 

the difference between total inflow and total outflow should theoretically equal to 0 for a steady-

state flow simulation or equal to the total change in storage for a transient flow simulation. To 

verify the accuracy of the results, MODFLOW calculates a volumetric water budget for the entire 

model at the end of each time step and saves it in the listing file output.dat. The water budget 

provides an indication of the overall acceptability of the numerical solution. If the accuracy is 

insufficient, a new run should be made using a smaller convergence criterion in the iterative solver. 

It is recommended to check the listing file by selecting Models |MODFLOW | View | Run Listing 
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File. This file contains other further essential information. In case of difficulties, this 

supplementary information could be very helpful. 

Step 5: Calculate zonal water budget 

There are situations in which it is useful to calculate water budgets for various zones of the model. 

To facilitate such calculations, flow terms for individual cells are saved in the file path | 

BUDGET.DAT. These individual cell flows are referred to as cell-by-cell flow terms, and are of 

four types: 

1. cell-by-cell stress flows, or flows into or from an individual cell due to one of the external 

stresses (excitations) represented in the model, e.g., pumping well or recharge; 

2. cell-by-cell storage terms, which give the rate of accumulation or depletion of storage in an 

individual cell; 

3. cell-by-cell constant-head flow terms, which give the net flow to or from individual fixed-head 

cells; and 

4. internal cell-by-cell flows, which are the flows across individual cell faces-that is, between 

adjacent model cells. The Water Budget Calculator uses the cell-by-cell flow terms to compute 

water budgets for the entire model, user-specified zones, and flows between adjacent sub regions. 

➢ To calculate zonal water budget 

1. Select Tools | Water Budget: The Water 

Budget dialog box appears (Fig. 1.8). 

 

Fig. 1.8. The Water Budget dialog box
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2. Click Zones. PMWIN displays the model grid. Click the button , if the display mode is not 

Grid View. The water budget of each zones will be calculated. A zone is indicated by a number 

ranging from 0 to 50. A number must be assigned to each model cell. The number 0 indicates that 

a cell is not associated with any zones. Follow the steps below to assign zones numbers 1 to the 

first and 2 to the second layer. 

3. Move the grid cursor to the first layer. 

4. Select Value | Reset Matrix, type 1 in the Reset Matrix dialog box, then click OK. 

5. Move the grid cursor to the second layer by pressing the PgDn key. 

6. Select Value | Reset Matrix, type 2 in the Reset Matrix dialog box, then click OK. 

7. Select File | Leave Editor or click the leave editor button . 

8. Click OK in the Water Budget dialog box. 

PMWIN calculates and saves the flows in the file path\WATERBDG.DAT. The unit of the flows 

is [L3T−1]. Flows are calculated for each zone in each layer and each time step. Flows are 

considered as IN, if they are entering a zone. Flows between zones are given in a Flow Matrix. 

HORIZ. EXCHANGE gives the flow rate horizontally across the boundary of a zone. EXCHANGE 

(UPPER) gives the flow rate coming from (IN) or going to (OUT) to the upper adjacent layer. 

EXCHANGE (LOWER) gives the flow rate coming from (IN) or going to (OUT) to the lower 

adjacent layer. For example, the flow rate from the first layer to the second layer (2.5788809E-03 

m3/s) is saved in EXCHANGE (LOWER) of ZONE = 1 and LAYER = 1. The percent discrepancy 

in the file is calculated by . 

In this example, the percent discrepancy of in- and outflows for the model and each zone in each 

layer is acceptably small. This means the model equations have been correctly solved. 

To calculate the exact flow rates to the well, we repeat the previous procedure for calculating zonal 

water budgets. This time we only assign the cell [25, 15, 1] to zone 1, the cell [25, 15, 2] to zone 

2 and the cell [25, 15, 3] to zone 3. All other cells are assigned to zone 0. The water budget is 
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shown in the water budget file generated by PMWIN. The pumping well is abstracting 

3.9644641E-05 m3/s from the first layer, 3.9760442E-04 m3/s from the second layer and 

7.5894612E-04 m3/s from the third layer. Almost all water withdrawn comes from the second 

stratigraphic unit, as can be expected from the configuration of the aquifer. 

Step 6: Produce Output 

In addition to the water budget, PMWIN provides various possibilities for checking simulation 

results and creating graphical outputs. The particle-tracking model PMPATH can display path 

lines, head and drawdown contours, and velocity vectors. Using the Results Extractor, simulation 

results of any layer and time step can be read from the unformatted (binary) result files and saved 

in ASCII Matrix files. An ASCII Matrix file contains a value for each model cell in a layer. PMWIN 

can load ASCII matrix files into a model grid. The format of the ASCII Matrix file is described in 

Section 6.2.1. PMWIN includes a built-in 2D visualization tool, which can be used to display 

contours of almost all kind of model results, including hydraulic heads, drawdown, concentration, 

and other values. 

We will carry out the following tasks in this step: 

1. Use the Results Extractor to read and save the calculated hydraulic heads. 

2. Create a contour map based on the calculated hydraulic heads. 

3. Use PMPATH to compute path lines as well as the capture zone of the pumping well. 

➢ To read and save the calculated hydraulic heads 

1. Select Tools | Results Extractor. The Results Extractor dialog box appears (Fig. 1.9). The options 

in the Results Extractor dialog box are grouped under six tabs - MODFLOW, MOC3D, MT3D, 

MT3DMS, and RT3D. In the MODFLOW tab, you may choose a result type from the Result Type 

drop down box. You may specify the layer, stress period and time step from which the result should 

be read. The spreadsheet displays a series of columns and rows. The intersection of a row and 

column is a cell. Each cell of the spreadsheet corresponds to a model cell in a layer. Refer to Help 

Section for details about the Results Extractor. For the current sample problem, follow steps 2 to 

6 to save the hydraulic heads of each layer in three ASCII Matrix files. 
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Fig. 1.9. The Results Extractor dialog box 

2. Choose Hydraulic Head from the Result Type drop down box. 

3. Type 1 in the Layer edit field. For this example (steady-state flow simulation with only one 

stress period and one-time step), the stress period and time step number should be 1. 

4. Click Read. Hydraulic heads in the first layer at time step 1 and stress period 1 will be read and 

put into the spreadsheet. You can scroll the spreadsheet by clicking on the scrolling bars next to 

the spreadsheet. 

5. Click Save. A Save Matrix As dialog box appears. By setting the Save as type option, the result 

can be optionally saved as an ASCII matrix or a SURFER data file. Specify the file name H1.DAT 

and select a folder in which H1.DAT should be saved. Click OK when ready. 

6. Repeat steps 3, 4 and 5 to save the hydraulic heads of the second and third layer in the files 

H2.DAT and H3.DAT, respectively. 

7. Click Close to close the dialog box. 

 

➢ To generate contour maps of the calculated heads 
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1. Choose Presentation from the Tools menu. Data specified in Presentation will not be used by 

any parts of PMWIN. We can use Presentation to save temporary data or to display simulation 

results graphically. 

2. Choose Matrix... from the Value menu (or Press Ctrl+B). The Browse Matrix dialog box 

appears (Fig. 1.10). Each cell of the spreadsheet corresponds to a model cell in the current layer. 

You can load an ASCII Matrix file into the spreadsheet or save the spreadsheet in an ASCII Matrix 

file by clicking Load or Save. Alternatively, you may select the Results Extractor from the Value 

menu, read the head results and use an additional Apply button in the Results Extractor dialog 

box to put the data into the Presentation matrix. 

 

Fig. 1.10 The Browse Matrix dialog box 

3. Click the Load... button. The Load Matrix dialog box appears (Fig. 1.11). 
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Fig. 1.11. The Load Matrix dialog box 

4. Click  and select the file H1.DAT, which was saved earlier by the Results Extractor. 

Click OK when ready. H1.DAT is loaded into the spreadsheet. 

5. In the Browse Matrix dialog box, click OK. The Browse Matrix dialog box is closed. 

6. Choose Environment from the Options menu (or Press Ctrl+E). The Environment Options 

dialog box appears (Fig. 1.12). The options in the Environment Options dialog box are grouped 

under three tabs. Appearance and Coordinate System allow the user to modify the appearance 

and position of the model grid. Use Contours to generate contour maps. 

 

Fig. 1.12 The Environment Options dialog box 
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7. Click the Contours tab, check Visible, then click the Restore Defaults button. Clicking on the 

Restore Defaults button, PMWIN sets the number of contour lines to 11 and uses the maximum 

and minimum values in the current layer as the minimum and maximum contour levels (Fig. 1.13). 

If Fill Contours is checked, the contours will be filled with the colors given in the Fill column of 

the table. Use Label Format button to specify an appropriate format. 

 

Fig. 1.13 The Contours options of the Environment Options dialog box 

Note that PMWIN will clear the Visible check box when you leave the Editor. 

8. In the Environment Options dialog box, Click OK. PMWIN will redraw the model and display 

the contours (Fig. 1.14). 
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Fig. 1.14. Contours of the hydraulic heads in the first layer 

9. To save or print the graphics, choose Save Plot As... or Print Plot... from the File menu. 

10. Press PgDn to move to the second layer. Repeat steps 2 to 9 to load the file H2.DAT, display 

and save the plot. 

11. Choose Leave Editor from the File menu or click the leave editor button  and click Yes 

to save changes to Presentation. 
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Using the procedure described above, you can generate contour maps based of your input data, 

any kind of simulation results or any data saved as an ASCII Matrix file. For example, you can 

create a contour map of the starting heads or you can use the Result Extractor to read the 

concentration distribution and display the contours. You can also generate contour maps of the 

fields created by the Field Interpolator or Field Generator. 

➢ To delineate the capture zone of the pumping well 

1. Choose PMPATH (Pathlines and Contours) from the Models menu. PMWIN calls the 

advective transport model PMPATH and the current model will be loaded into PMPATH 

automatically. PMPATH uses a "grid cursor" to define the column and row for which the cross-

sectional plots should be displayed. You can move the grid cursor by holding down the Ctrl-key 

and click the left mouse button on the desired position. 

Note that if you subsequently modify and calculate a model within PMWIN, you must load the 

modified model into PMPATH again to ensure that the modifications can be recognized by 

PMPATH. To load a model, click  and select a model file with the extension .PM5 from the 

Open Model dialog box. 

2. To calculate the capture zone of the pumping well: 

a. Click the Set Particle button  

b. Move the mouse cursor to the model area. The mouse cursor turns into crosshairs. 

c. Place the crosshairs at the upper-left corner of the pumping well, as shown in Fig. 1.15. 
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Fig. 1.15 The sample model loaded in PMPATH 

d. Hold down the left mouse button and drag the crosshairs until the window covers the pumping 

well. 

e. 

Release the left mouse button. An Add New 

Particles dialog box appears. Assign the 

numbers of particles to the edit fields in the 

dialog box as shown in Fig. 1.16. Click the 

Properties tab and click the colored button to 

select an appropriate color for the new 

particles. When finished, click OK. 

 

Fig. 1.16 The Add New Particles dialog 

box 
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f. To set particles around the pumping well in the second and third layer, press PgDn to move 

down a layer and repeat steps c, d and e. Use other colors for the new particles in the second and 

third layers. 

g. Click to start the backward particle tracking. PMPATH calculates and shows the 

projections of the pathlines as well as the capture zone of the pumping well (Fig. 1.17). 

 
Fig. 1.17 The capture zone of the pumping well (with vertical exaggeration=1) 

To see the projection of the pathlines on the cross-section windows in greater details, open an 

Environment Options dialog box by choosing Environment... from the Options menu and set a 

larger exaggeration value for the vertical scale in the Cross Sections tab. Fig. 1.18 shows the 

same pathlines by setting the vertical exaggeration value to 10. Note that some pathlines end up at 

the groundwater surface, where recharge occurs. This is one of the major differences between a 

three-dimensional and a two-dimensional model. In two-dimensional areal simulation models, a 

vertical velocity term does not exist (or always equals to zero). This leads to the result that pathlines 

can never be tracked back to the ground surface where the groundwater recharge from the 

precipitation occurs. 



29 

 

 

Fig. 1.18 The capture zone of the pumping well (with vertical exaggeration=10) 

PMPATH can create time-related capture zones of pumping wells. The 100-days-capture zone 

shown in Fig. 1.19 is created by using the settings in the Particle Tracking (Time) Properties 

dialog box (Fig. 1.20) and clicking . To open this dialog box, choose Particle Tracking 

(Time)... from the Options menu. Note that because of lower hydraulic conductivity (and thus 

lower flow velocity) the capture zone in the first layer is smaller than those in the other layers. 

 

Fig. 1.19 100-days-capture zone calculated by PMPATH 
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Fig. 1.20 The Particle Tracking (Time) Properties dialog box 


